Introduction to Mathcad

Theoretical and Practical training

TASK:

1. Get to know with theory and MathCad interface;
2. Check rules for evaluations and graphs’ plotting;
3. Try all examples presented in the following slides.
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Definition

» Mathcad is a product of MathSoft inc. The
Mathcad can help us to calculate, graph,
and communicate technical ideas. It lets
us work with mathematical expressions
using standard math notation - but with
the added ability to recalculate, view,
present, and publish with ease, even to
the Web.
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Functionalities provided by Mathcad

» Numeric operators perform summations, products,
derivatives, integrals and Boolean operations.

» Numeric functions apply trigonometric, exponential,
hyperbolic and other functions and transforms.

» Symbolics simplify, differentiate, integrate, and transform
expressions algebraically.

» Vectors and Matrices manipulate arrays and perform
various linear algebra operations, such as finding
eigenvalues and eigenvectors, and looking up values in
arrays.

» Differential Equation Solvers supFort ordinary differential
equations, systems of differential equations, and boundary
value problems both at the command line and in solve
blocks that use natural notation to specify the differential
equations and constraints.
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User Interface: Menus and Toolbars

» MathCad is a window program as shown in the following screen shot
after run the Mathcad program.

» To open MathCad software go to Start(Iyck)[IProgramms
(Mporpammbl)L1MathL1Mathcad 11 Enterprise Edition

™ Mathcad Professional - [Untitled:1] =g
|s] File Emvgin.vF;tmrc:ytr “window H&ﬂ

JD gm@@&u B@| o

Press F1 for help. Bota [ [Pl 4

» The blank area is the work area that allow us typing and evaluating
mathematical expression, graphing, symbolic computing, entering and
running Mathcad scripting codes, and entering ordinary text.
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User Interface: Menus and Toolbars

» It has standard main menu bar at the top of the window as most
window programs do that is shown in the following screen shot.

| Fille Edit “iew Inset Format Math 'féi'j,-rn'rtialit:s indowy Help

» The View Menu. The View menu, among other features, allows a
user to bring up popup menu bars for using with Mathcad .
Mathcad has nine popup toolbars that for entering math formulas,

mathematical symbol, graphing, programming, etc. We can choose to
bring up each one at a time or bring up the top level popup menu
toolbar by selecting Math.
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Graph Toolbar

»  The graphic toolbar contains toolbars for creating 2D-graph and
3D-graph that are most useful for our purpose.

»  First click on any blank spot in the work area, which tells Mathcad

where to place the graphic region; then click on the | or type
Mathcad creates a 2D graphic region at the
selected location that can be used to graph any equation or

vector pair {Y; X}.
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Vector and Matrix Toolbar

»  The Vector and Matrix Toolbar contains toolbars for creating
and manipulating matrices.

»  The most frequently use menu selection in the matrix popup §
toolbar is the create matrix icon, [@ which upon click will

bring up a dialog box that allow us to create a matrix with specified
number of rows and columns. Another way to bring up the matrix creating
dialog box is press :

»  Matrix with one row or column is a vector. The matrix popup toolbar
also contains menu selections that heIF us to find eigenvalues and
eigenvectors, to access each individual row or column, or find inverse.

» Using hot-key or function-call is a much quick way to invoke the menu
selection.

» For example, to find inverse of an given matrix A, we only need to
tyFe A~N{-1} (which will show as Ail in the workplace) and = (which
tells Mathcad to execute the operation) to find it.
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Evaluation Toolbar

»  The Evaluation Toolbar contains tool bar for assignment operator : =,
global definition operd&r  , and the evaluation command =.

> in Mathcad , equal sign = is used as evaluation command that
tells Mathcad to carry out the computation.

» There are two execution mode, one is automatic, in this mode,
Mathcad carries out execution when we press [=]; another is
manual, in this mode you will have first press [=] followed by [F9]
key to let Mathcad to carry out the execution.

» The manual mode is desirable when we want to delay the execution
and don’t want to be bothered by many error message Mathcad
would produce in automatic mode. You turn off/on the automatic
mode from the Math menu on the Main Menu bar.
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Evaluation

» In the automatic execution mode, after we type we get

» If we want to assign 2 to variable x we will have to type , Which
will be displayed as in the work area. Therefore, a mathematical
expression

will be enter differently according to the meaning of the expression.
If you want sign : — to appear press [Shift] and then press [:]

1. Entering it as when x value has been defined before this
expression and you want y to be the value of , 1.e. assign
the value of x+ 3 to y.

2. Entering it as when we want to set y as a function of x
defined as x + 3.

3. Entering it as when we like to compare y and x + 3, i.e.

to logically determine if Iy has the same value as x+3, here "[Ctrl]="
mean enter ‘=" while hold the '[Ctrl]" key.
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Boolean Toolbar

» We can get the logic equal sign = from the
Boolean Toolbar as shown .

» The global assignment operator & (shortcut ~ ) is to assign an value
(expression) to a variable (a function) so it can be referred in any
place of the work area. The following screen shot illustrates the
difference betweens;, :=, =, and

.* Mathcad Professional - [Untitled:1]
L{_a] File Edit WYiew Insert Format Math Symbolics Window Help

| | -3 |
—y | LJ (= TS e - | mjm =
D ¥ D E | 5 Iﬁ l:f?( 1 '.’;—‘ !:I:-:] ﬂ Eeie

7y'= x+3 xis not defined but comparing is ok
v=x+3 xIs not defined, so an error in assignment

| x=5 assignStox  y=x+3 assignx+3, whichisBtoy entery=toget y=8

|v(x) = x+3 define a function y(x)= x+3, math equations should be entered this way in general.
|entered y(3)=toget w3 =28 y=x+3 X hastobe globally detined too!
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Defining of variables

A variable or a function must be defined before it is used.

The & will give us a leverage to defy this scan order so we can
define and use a variable (function) without worrying about the
proper order demanded by the Mathcad as illustrated in the following
two screen shots. red font indicate a error.

.* Mathcad Professional - [Untitled:1]
|G) File Edi View Irsen Fomat Math Symboics Window Help

;=3 xis defined on right with := so an error

Thiz variable o funcion N i ;
el v+2=5 yis defined onright and

below with global definition, no error!
tis defined before its use, no error

y =3
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Calculus Toolbar

The Calculus Toolbar as shown allow us to perform computations
found in Calculus.

Calculuz E3
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Arithmetic And Radical Operators

» One important concept in entering expression in Mathcad is the
. It is a little dark rectanﬁle box . For example, when you type +
(addltlon operator) in any blank area we get O=ar

» In the place holders we enter any valid mathematics expression.
Mathcad uses arithmetic operators in the same way as standard
calculator. The following table list the keystrokes for arithmetic
operators, root operators, and subscription (indexing).

‘:l_ll ytract -_ type an expression in m

qulal_e root - type an expression in m

[(qtll] \‘\ t " root C‘tll]\‘ type index in the first = and
radicand in the second
‘:nUbBCIlpt _ type subscripts separated by , ina

Korchak Tatiana Viktorovna «KhAI» Informatics Department 13




Assignment And Relational
Operators

Entering text type any text in »

range i if enter 4 in w, a will have values

—

variable
global A i — assign 3 to a globally

assignment

[ -‘tl'l] [:] ' [ N ][ ] ‘ a is logically equal to 1

greater than type an expression in a
less or equal Ctll] [Q] type an expression in s

greater 3 = type an expression in =

equal

type an expression in

Korchak Tatiana Viktorovna «KhAI» Informatics Department

14



Calculus And Matrix Keystrokes

Usage
[thft][/] derivative [Shlft][/] . variable in w at denominator
and function in other »
[Shift][Ctrl][/] nth [Shift][Ctr]][/] T ——

derivative able in g at denominator after

d and function in last =

(1t1 1] [I indefinite C‘tll ncln integrant in first m and integral
integral variable in second m

[Shift][T](&) | definite [Shift][7] gudns integrant in first w and integral
integral variable in » after d
[Ctl‘l] [I\I] add matrix [C‘tll] [I\I] - dia.log box specify rows and columns in

get a row of P\I[Cttl‘l] [6] f=a= specify row number in g, which

a matrix is between 0 and rows(M)-1 in-

clusive.
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Different meanings for =

Since in mathematics x = y has four different meanings,

(1) definition: defines functions or notation, for example, in the
expression f(x) = x2 + 1, one defines a function f by an ex-
pression x% + 1.
assignment: assigns value of y to x; like in the sentence “set x

=3

logical equal: x is equal to y logically; like in the sentence “if
X =W v

result of computation: like “ 4 + 5 = 9”7 here 9 is result of
adding 5 to 4.

Mathcad uses -~ as execution command, that is to tell Mathcad to compute

the value. It uses (. ) for assignment and definition, and ( ) for
logic equal.
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General Editing Methods

» As in most window based text editors, we can use mouse to choose
input starting g oint by moving mouse cursor to a desired point and
click the right button.

» Every Mathcad equation, text paragraph, and plot in a worksheet is a
separate object called . We can also use mouse to select
several regions and drag them around.

» To select one region, ﬂust move mouse over the region and click. A
light bounding box will appear, which indicates the region is selected,
as in the following screen shot for a selected math region.

-». Mathcad Profeszional - [Untitled:1] +* Mathcad Professional - [ntltled:1]
|£T FLIE Edrf "-.J'IEW Inzert  Format Haﬂ"l 54.'I'1||‘.‘":I1IE,3 |E1 File Edit “iew Insett Fomat Math i.xE'r_Ernhu:.iio:e-;- Sfindow Help

selected text region

A 5el _n;u::ted math region

el This is a text box g:=1.10 This is range variable

This is range variable
riltiple selected

y reqions
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Define Variables

There are two type variables in Mathcad, a normal variable which holds one
value, and a range variable which, like vectors in math, holds multiple values.
The variable name is any sequence of letters and dlglts that begin with a letter
such as a; al; bx12; etc. To define a normal variable you just click any clear
region and type the name of the variable followed by :, which bring up the
assignment operator := and foIIowed by the numeral value.

I
eystrokes x:23 defines —

a variable named x ax: 1 3 10 | az:=1, 3 10 | ex takes values 1, 3, ... , 10,
Whose Value IS 23’ Wh|C incremented by 2. Notice the
is displayed as a := 23 s b
in the worksheet. g : g i

. abl:0..1;10 | abl :=0,.1..10 | abl takes values 0, 0.1,0.2, ...
To defined a range | |
Vanable, usua”y an _ . 10, incremented by 0.1,
index Variab|e, we use ale {{.16110,9;1 ale := ].U, 9.. ale takes values 10, 9, ... , 1,

Sem|COIOn The decremented by 1.

fO||OWIn9 table list ac:10,9.8:1 | ac := 10,9.8..1 | ac takes values 10, 9.8,9.6, ...
Several type Of range . 1, decremented by 0.2,

variables:
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Define and graph Functions

» To define a function in Mathcad is same as to write down a function in a
piece of paper. You just type in the function name, followed by open
parenthesis = and the argument(s) that are separated by comma( ) and
the close parenthesis , then type the assignment operator — colon( )
followed by typing in the expression(formula) for the given function.

»  For example to define a function f(x) = 4x + 3, we would type f(x):4x+3,
notice Kou don't need to type the multiplication operator between 4 and x
as Mathcad automatically insert it for you. However, if you want to define
a function such as f(t; y) = 3t + ty, you would need to specifically type in
the multiplication operator *, as shown,

» also notice that we should type no space between terms as Mathcad will
insert it for us when we type in a arithmetic operator. When typing in an
expression involving more than one terms, space character serves as
grouping operator. Hitting space bar will cause Mathcad to group term
together. This is useful when entering expression )

» here we will need to group x + 3 together by 3r—5

press space bar before we type the division operator(/). Another usage of
space is to move out the superscript or subscript mode.
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The usage of space

The following table gives several example to illustrate the usage of
space. Notice, in order to move out of the denominator, we need to press

space too.

Dlsplay Remark

"2+3X

-~

No space is tvped after = so
Mathcad continue entering the
expression as exponents.

A space is typed after

so Mathcad exists the power
mode and enter 3r as another
term.

No space is typed after [, the
subindex operator so Mathcad
continue entering the expres-

sion as subindex.
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x+3/4x+5

X+3 /4x+5

Display

A space is typed after [
so Mathcad exists the power
mode and enter 3r as another
term.

No space is tvped before / so
Mathcad interprets as 3 di-
vided by 4z + 5.

A space is typed before / so
Mathcad groups = + 3 and

treats 1t as numerator.




W~V

Value of a function

To find value of a function, such as f(3), or h(4; 2):

define the function = and ¢ (i.e. )}
type f(3)= or h(4,2)=.

To graph a function of one variable after defining it:

click any blank space after the definition of the function;

type @ or from Insert menu choose to insert xy-plot.

A box will appear with several place holders. Enter the function name
on the left center place holder and the variable on the bottom center
place holder.

If the variable name is not used before, the Mathcad will display a
graph over default interval [-10, 10].
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To graph a function, we do:

Define the function.
Define range value for the variable of your function.

Press @ and enter the function name and variable name in proper
place holder.

Adjust the thickness of the trace.

Adjust the y ranges by changing the numbers on the far left (see the
graph below).

We have two screen shots here,
the first one shows a blanket
graphing box with place holder
and another graphing box display
graph of f(x):=1/3x(3-x)

over interval[-4, 4].

h
THis is what you s\ge after type @ after enter » and f(x) in proper place
"place holder for variakle

place holder for
function
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